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ESSENTIAL KURZWEIL 3000 SKILLS  

(Version 10) 
�

1.  The Kurzweil 3000 Tool Bars 
 

�  There are four tool bars on the Kurzweil 3000 screen.  These tool bars contain 
icons that offer convenient access to the functions and features of the program. 

 

�
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�
Reading Tool Bar 

�

�
Study Skills Tool Bar 

 

 
Writing Tool Bar 

 
�  All four of the tool bars can be shown on the screen at the same time. 

Alternatively, all four can be hidden.  Any of the tool bars may be open on its 
own, or in combination with any of the others.  With unneeded tool bars closed, 
you have more work space available to work with material on the screen. 

 
�  The following illustration shows all four of the tool bars open, with the Menu Bar 

above them.  (All functions can also be accessed by the Menu Bar.) 
 

 



�  If you want to close a tool bar, click on the coloured vertical tab at the left edge 
of the tool bar.  For example, to close the Study Skills tool bar, click on the 
green tab.  The coloured tab will remain visible when the tool bar closes, and 
you can re-open the toolbar by clicking on it again.  

 

 
 

�  It is easy to add icons to a toolbar or to remove them.  Place the cursor in the 
gray area anywhere to the right of the icons and right-click the mouse. 

 

         

�  On the dialogue box that opens, and click on Customize Toolbars … �
�

�  This will open the dialogue box shown below.  To add a Scan icon to the Main Toolbar, 
do the following in order:  1) Click on the scanner icon; 2) Click on the arrow pointing 
up; 3) Click Apply; 4) Click OK.  (If you wish to reposition the icon on the toolbar, use 
the blue arrows beside the up and down arrows before clicking the "Apply" button.)�
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2.  Scanning Teacher Prepared Material  (worksheets, tests, etc.)  
 
�  Make sure your scanner is connected to the computer before opening 

Kurzweil 3000, and then open Kurzweil 3000. 
�  Place material to be scanned on scanner platen (glass surface). 
�  Click Scan button on Main Tool Bar in Kurzweil 3000. Or, if there is no Scan 

button on the Main Tool Bar, select "Start New Scan" under the Scan Menu. 
 
      (NEVER try to scan using a scan button on your scann er!) 

 

 
 

�  Wait for document to scan and show up on-screen in Kurzweil 3000. 
 
 
 

3.  Working On-screen With Teacher Prepared Materia l 
 

�  Kurzweil 3000 normally orients paper correctly (right side up).  If it fails to do 
so, select “Rotate” under the “View” menu.  Then choose “Right”, “Left”, or 
“Invert” to correct the page orientation: 

 

 
 
 

�  To write (type) on the page that you have scanned to the computer screen, 
you must add a “text note” by clicking the text note icon on the Study Skills 
toolbar. 
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�  The text note will appear wherever you click on the page after clicking the text note 
icon.  If a cursor is flashing in the empty text box, you can begin typing. The text 
box will expand as you type into it.  If the text note becomes a solid orange box, 
click in it and then begin typing. To reposition a text box, just click on it and drag it 
(while continuing to hold the left mouse button down) to the spot on the page where 
you want it. 

 
 
 

 
 
 

�  In order to add a new text box, you have to click somewhere outside a text box 
before clicking on the Text icon. 

 
 The illustration below shows a worksheet with three text boxes.  The first has a cursor 
 flashing in it, and the other two are solid orange boxes.   
 
 

 
 
�  You can type directly into a text box.   
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�  Or, you can copy and paste into a text box. 
 
�  For example, to copy a definition from the Kurzweil Dictionary, select the word on 

your page for which you want a definition. 
 

 
�  Then click on the “Definition” icon on the Main Tool bar. 

 
 

 
 

�  When the definition dialog box opens, highlight the definition by putting the cursor 
at the beginning of the definition and then holding down the left mouse button while 
you drag the cursor over the rest of the definition.   Then hold down the Ctrl key and 
type C (or go to the Edit menu and click “Copy”, or copy in any other way that you 
normally copy text)  
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�
�  Close the Definition dialog box by clicking on the red X in the top right corner.  Then 

click inside the text box where you want to paste the copied definition.  Hold down 
the Ctrl key and type V (or paste in any other way that you normally paste text).  In 
the illustration below, the definition has been pasted into the appropriate text box. 

�
�

�

�
�

�  Text can also be selected, then dragged and dropped into a text box. 
 

�  [If selecting text is new to you:  select the text by left-clicking at the beginning of the 
text. Then, while holding down the left mouse button, drag the cursor to the end of 
the text to be highlighted.  When you let go of the left mouse button, the text will be 
highlighted.  If you are selecting a single word, you can do so by double-clicking on 
the word.] 

 
�  Once the text is selected, put the point of your cursor somewhere in the selected 

text, and then hold down the left mouse button.  While holding down the left mouse 
button, drag the little “envelope” that appears until the cursor is inside the text box.  
Then release the left mouse button, and the text should appear in the box. 

�

�
�
�
�
�
�
�
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NOTE:  You may need to change properties of text in a text box.  You can change 
properties such as font, size, and colour.  When you make a change, however, the 
change will apply to all text boxes in the file.  Changing note properties is easy.   

 
�  Select "Properties" under the File Menu. 

                                                                            
 
�  Select "Text Notes" from the column on the left to bring up the note options 

that are shown below on the right.  After making desired changes, click on 
OK to return to the page you are working on.  The changes you make here 
will apply only to text boxes in this file.  Default settings will not be affected. 

  

�  
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�  To change the default note options, right-click inside a text note on your page.  This 
will bring up the context menu shown below.  Click on "Default Note Options". 

  

                              
�

�  When the dialogue box shown below opens, use the options shown on the right half 
to make desired changes and click OK.  This will change the default settings for 
Text Note options.  [The left half of this dialogue box is used in exactly the same 
manner to change Sticky Note default options.]�

 

�
 
 
�
�
�
�
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4.  Scanning Text Books, Novels, and other Publicat ions 
�
�  Make sure scanner is connected to computer before opening Kurzweil 3000. 
�  Open Kurzweil 3000.  
�  Place material to be scanned on scanner platen (glass surface). 
�  Click the Scan button on Main Tool Bar in Kurzweil 3000. 
 
 (NEVER try to scan using a scan button on the scanne r!) 

�

�
�  Wait for the page to scan and show up on the screen in Kurzweil 3000 
 
�  After scanning the first page of your document, be sure to save your work. 
 

o Click the Save icon on the Main Tool Bar   
 
o When the dialogue box shown below opens, type a name for your file and 

click the Save button beside the name you've given your file. 
�

�
 By default, Kurzweil 3000 saves all files to a folder entitled "Kurzweil 3000" which is 
 found inside another folder called "Kesi".  The Kesi folder is placed inside "My 
 Documents"  when Kurzweil 3000 is installed on your computer.  You may make as 
 many folders as you wish inside "Kurzweil 3000". 
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Please note when scanning... � �

� �
Note 1:   If scanning a multiple-page document, follow the above steps for each subsequent     
page.  When you click the Save button on the Main Toolbar after scanning additional     
pages, the new pages will simply be added to the end of your file. 
 
The Reading Toolbar shown below indicates that you are on page 2 of a 6 page     
document. 

�

�
Note 2:  If you need to rescan a page, you can do so as follows:   
 

�  make sure that the page you wish to re-scan is on the screen 
�  open the Scan menu and select "Rescan Page" 
 

�
�
�  The page will be rescanned, and the original scan will be replaced. 
 
 
�  You can use the Scan menu in a similar way to insert or delete a page. 

 
 
 

�
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5.  Reading Scanned Material 
�

�  With the document you wish to read open in Kurzweil 3000, place the cursor at the 
point where you wish to hear the text read aloud to you.   Then click on the Read 
icon on the Main Tool Bar.  As Kurzweil begins reading the selected text, the Read 
icon will become a Pause button so that you can stop the reading and then begin 
again where you leave off. 

��

�

�
 

�  If you wish to change the reading rate, you can increase or decrease the words per 
minute by clicking the up or down arrow on the Reading Tool Bar. 

�
�  If you wish to adjust the size of the text on the screen as you follow the text that is 

being read, you can zoom in or out by clicking the up or down arrow on the Reading 
Tool Bar. 

�
�
�

�
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6.  Using Basic Study Aids With Scanned Material 
�

6.1  Sticky Notes and Text Notes 
�

�  To add a sticky note to a scanned page, click on the Sticky icon on the Study Skills 
Toolbar. 

�

�
�

�  Then click on the screen wherever you want the note to appear, and a sticky note 
will appear with a flashing cursor inside.  You may now begin typing inside the note.  
The note will expand to include as much text as you put into it.  If you press the 
“Enter” key, the text you type will continue on a new line. 

�
�

�
�

�  Text notes can be added in exactly the same way.  Text notes have a transparent 
background so you can see through them to whatever is on the page behind. 

�
�
�
�

�
�
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�  Sticky Notes and Text Notes can be repositioned and placed wherever you want on 
a scanned page by dragging the cursor over the note until a cross appears.   

�
�  When the cross appears, hold the left mouse button down and move the mouse 

until the note is where you want it to be.  When you release the mouse button, the 
note will remain in the new position. 

 
 

�  To delete a sticky note or a text note, click inside the note to select it.  Then click 
the “Delete” icon on the Study Skills Tool Bar 

�

�
�

�  Click Yes when asked if you want to permanently delete the selected note. 

�
�

�
�

�
�

�
�
�
�
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6.2  Highlighting and Extracting Text 
�

�  On the Study Skills Tool Bar there are four colours of highlighter pens. 

 
�

�  To highlight text, click on the colour of your choice.  The cursor becomes a 
highlighter pen.   Place the highlighter pen at the beginning of the text that you wish 
to highlight.  While holding down the left mouse button, drag the highlighter pen 
over the text to highlight it.  Release the mouse button when the entire selection is 
highlighted. 

�

�
�  On the Study Skills Tool Bar, there is an “Erase” tool you can use to erase 

highlighting. 

�  Use the erase tool in exactly the same way as the highlighter pens. 
�

�  You can “extract” highlighted text and/or notes from scanned material into a 
separate file.  For example, you may wish to highlight the main ideas in a passage: 
so that you can review them later.   

�

�
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�  To extract the text that you have highlighted, 
open the File Menu and select “Extract".  
When the Extract Box opens, select Extract 
Annotations. 

�

�  Make sure that Highlights is selected, 
as well as the colour or colours of the 
highlights that you wish to extract.  
Then click OK.�



�
�  A new window containing your extracted highlights will open.  While this window is 

open, it can be saved as a new text file by selecting “Save As” under the File Menu.  
You can use the erase tool to erase the highlighting in the new file, and you can 
edit to make any other changes that you want in the new file. 

�

�
�  Text Notes and other annotations can be extracted from scanned material in the 

same way. 
 
�  You may save the new text file containing the extracted information in the same 

way in which you normally save files. 

 
 

�
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7.  Writing With Kurzweil 3000 
�

�  Kurzweil 3000 is not intended to be a full featured word processor.   
 
�  Even though it is not really a word processor, Kurzweil 3000 can be used as a 

powerful writing tool.  You can use Kurzweil 3000 to write and then have it read 
your writing back to you so that you can hear what you have written for editing 
purposes. 

 
�  In order to use Kurzweil 3000 for writing, click on the “New” icon on the Main Tool 

Bar. 

�
�

�  This will create a new text document, and you can begin typing into it.  (A text file is 
different than an “image file” that is created when you scan into Kurzweil 3000.) 

�

�
�  To listen to what you have written, put the cursor where you want Kurzweil to begin 

reading and click the “Read” icon on the Main Tool bar. 
 

�  When you save what you write in Kurzweil 3000, it will be saved in a format that 
can be opened by a word processor such as Microsoft Word.  Just open your word 
processor, find the file you wrote in Kurzweil 3000 and open it in the word 
processor. 

�

�
�
�
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8.  Using The Zone Editor  
�

�  When you scan material into Kurzweil 3000, you may find that it does not read 
blocks of text on a page in the correct order.  To fix this problem, you must use the 
Zone Editor. 

 
�  Open the Scan Menu and select "Zone Editor". 
 
 

 
 
 
 
�  Turning on the Zone Editor will enclose the blocks of text on the page in boxes and 

the numbers above the boxes indicate the order in which the "zones" will be read 
by Kurzweil 3000.  This is illustrated on the following page. 

 
�  The Zone Editor allows you to rearrange the order in which the blocks of text are 

read, eliminate text that you do not want to have read, and make other adjustments.  
If you wish, you can delete all of the reading zones made by Kurzweil 3000 and 
create your own by starting from scratch. 

�
�
�
�
�
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�
�
�

�  To begin making changes, select a zone by left-clicking on it.  With the zone 
selected, right click on it to bring up the dialogue box, as shown below. 

�
 

 
 

�  If there is a block of text that you do not wish to have Kurzweil read, select "Delete 
Zone".  If you wish to adjust the size of a zone, choose "Adjust Zone".  If you wish 
to change the order in which zones are read, select "Properties".  To start from 
scratch, or add a new zone, select "Add Zone".  You may also turn off the Zone 
Editor. 
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�  In the example below, all zones will be deleted so that new zones can be 

created where they are needed.  This will enable Kurzweil 3000 to do a better 
job of reading the text. 

�
�

�  After all the zones have been deleted, right click anywhere on the page to re-
open the Zone Editing options.  Then select "Add Zone". 

 

 
 
�  When the cross appears, hold the left mouse button down and drag down and 

toward the right to create the new zone.  When you let go of the mouse button, 
you will have a new zone on the page.   

 

�
�
�
�
�
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�  This new zone can be moved and/or resized in the usual way in which boxes 
are moved and resized in a Windows environment 

 

�
 
�  When you have finished editing the reading zones on a page, left click on the 

page to open the Zone Editing options and click on Zone Editor to de-select it.   
 

�  If you wish to keep the changes you have made, click ok when warned that your 
changes will permanently affect the document. 

 

 
 
 Note:   You cannot resume working in Kurzweil 3000 until the Zone Editor is turned off. 
 
 

Prepared by Paul Hamilton 
September, 2006 

phamilton@setbc.org 


